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PTReportGen Frequently Asked Questions 
 

About 

 

What is PTReportGen? 

PTReportGen is a report generator for Microsoft PowerPoint that uses 

Microsoft PowerPoint as reporting tool and outputs reports in Microsoft 

PowerPoint format. 

 

What can I do with it?  

If you know how to use Microsoft PowerPoint and write SQL statements, you 

can use PTReportGen to create all kinds of reports as you need. The report 

generated by PTReportGen is a Microsoft PowerPoint presentation or other 

format file, such as GIF. 

 

What are the main features?  

- Using Microsoft PowerPoint as your reporting tool 

- Making report template directly using Microsoft PowerPoint 

- Accessing to databases using SQL 

- Creating reports without programming experience 

- Connection to all databases using ODBC 

- Supporting multi-databases in one report 

- Generating reports with parameters 

- Supporting Windows mode and command line mode 

- Creating complex reports 

- Creating reports with charts 

- Creating reports with pictures 
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- Many reports in one Microsoft PowerPoint presentation 

- Conversion of file formats 

- Generating reports automatically 

- One time configuration 

- Flexible deployment 

 

Can I make the complex report using PTReportGen? 

Yes. This is a main feature of PTReportGen. The complexity might come from 

reports formatting as well as reports content. 

- The complex report formatting  

You design reports like layouts, styles, formatting directly using Microsoft 

PowerPoint. You can take full advantage of Microsoft PowerPoint including 

text formatting, tables, charts, pictures and graphics, drawing, headers and 

footers, and more. 

- The complex report content 

In one report, you can execute more than one SQL statement, and get data 

using different queries. Further more, you can create a temporary table, 

prepare data using many SQL statements including 

INSERT/UPDATE/DELETE/INSERT SELECT, and then make a report.  

 

Do you have any server version which I can use on the server to generate 

the reports?  

No. But PTReportGen can be run on your desktop or server. So you can use 

PTReportGen on the server to generate the reports. If you want to run it in the 

background on the server, you need to run it in command line mode. 

 

What is the system requirement?  

- Microsoft Windows 95, Windows 98, Windows NT, Windows 2000, Windows 
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XP, Windows 2003 or later.  

- Microsoft Office 2000, Office XP, Office 2003 or later.  

 

Installation 

 

How to install it? 

Unzip the download file. Run setup.exe, and follow the instructions to complete 

installation. 

If you don’t have installed Microsoft Office, please install it first. 

If your environment is Windows 95/98 and Office 2000, and you don’t have 

installed VB6.0 run-time files, please install it. For Windows 2000, Windows XP, 

Windows 2003 and Office 2000 or later, you do not need to install VB6.0 

run-time files because they are included in these OS and Office. To install 

VB6.0 run-time files, just run vbrun60sp5.exe, and follow the instructions. 

If you don’t have installed ODBC Driver for the database you want to access, 

please install it. 

If your OS is Windows 95/98 and you don’t have installed MS Data Access 

Components 2.0 (MDAC_TYP) or later, please install it. For Windows 2000, 

Windows XP and Windows 2003, you do not need to install MDAC_TYP 

because it is preinstalled in these OS. To install MDAC_TYP, just download 

and run mdac_typ.exe. 

 

How to uninstall it? 

You can uninstall PTReportGen from [Control Panel]. 

1. Double-click the Add/Remove Programs icon in the Windows Control Panel.  

2. Do one of the following:  

n  For Windows 2000, Windows XP and Windows 2003 Edition:  

Click PTReportGen in the Currently installed programs box, and then click 
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the Change/Remove button. 

n  For Windows 98 and Windows NT 4.0:  

Click PTReportGen on the Install/Uninstall tab, and then click the 

Add/Remove button. 

3. Follow the instructions on the screen to complete uninstall. 

 

Reporting with PTReportGen 

 

How does it work?  

To create a report with PTReportGen, you should do as follows: 

1. Create a report template file using Microsoft PowerPoint, and define the 

layouts, styles, formats of reports. 

2. Create a PTR file with a .ptr extension using PTReportGen. The PTR file tell 

PTReportGen how to extract data from database, and where and how to put 

data. 

3. Run the PTR file to generate a report in Microsoft PowerPoint format. 

 

Where can I find some samples? 

After PTReportGen is installed, some sample reports are installed too. The 

sample reports include a sample database, some report template files (.ppt) 

and PTR files (.ptr). They are located in the PPTReport directory under 

\Samples. 

 

What need I do to use samples? 

To use these samples, you must add a data source named “Report Sample”, 

and specify the database “Sample.mdb”. If you have not installed MS access 

ODBC driver, please install it first. 

Creating a System DSN for a Microsoft Access Database 
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1. Click the Windows Start button, choose Settings, and then click Control 

Panel. 

2. On computers running Microsoft Windows 2000 or later, double-click 

Administrative Tools, and then double-click Data Sources (ODBC). The 

ODBC Data Source Administrator dialog box appears. On computers 

running previous versions of Microsoft Windows, double-click 32-bit ODBC or 

ODBC.  

3. Select the System DSN tab, and then click Add button. 

4. Choose Microsoft Access Driver (*.mdb), then click Finish button.  

5. In the ODBC Microsoft Access Setup dialog box, type Report Sample in 

the Data Source Name box. 

6. Click the Select button, and browse to select Sample.mdb. 

7. Click OK button to close the ODBC Microsoft Access Setup dialog box.   

8. Click OK button to close the ODBC Data Source Administrator dialog box. 

 

How can I use these samples? 

1. Run PTReportGen. 

2. Open a PTR file. Click Open on the File menu. 

3. Run the PTR file to generate a report. Click Run on the Report menu. 

4. Open, view and check the report. Click Open Report File on the File menu. 

5. Open, check the log file. Click Open Log File on the File menu. 

The sample reports can be changed to adapt to your own needs. 

 

When I use samples, I receive a "Selected Collating Sequence Not 

Supported" error message. 

This is a problem of multilanguage. You are trying to open a database or an 

object in a database that was created in another language edition of Microsoft 

Access. You can try as follow: 
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1. Open the database "sample.mdb" using Microsoft Access.    

2. On the Tools menu, click Options, and then click the General tab.   

3. Make sure that the New Database Sort Order is set to General and then 

click OK. 

If you do not resolve the problem, please install or enable multilanguage 

support for your operating system. For more information, please refer to 

http://support.microsoft.com/default.aspx?scid=KB;en-us;q202150 

http://support.microsoft.com/default.aspx?kbid=184988 

You can create a new database on your computer, export data from 

“sample.mdb”, and import into your database. 

 

What is a report file? 

The report file is a Microsoft PowerPoint presentation generated by 

PTReportGen. 

 

What is a report template file? 

To make a report using PTReportGen, you should create a report template file 

first. This report template is a Microsoft PowerPoint presentation that defines 

the layouts, formats and styles of the report. In the report template, you can 

input static content such as titles, descriptions, comments, a cover, a company 

logo, and set the format for the static content and data got from data sources. 

 

What is a PTR file? 

To generate a report with PTReportGen, you must create a PTR file with a .ptr 

extension. The PTR file contains information such as the name of the report 

template file, the name of the report file, log file name, data sources, 

parameters and functions. The PTR file tells PTReportGen how to get data 

from data sources and how to put data into a report. 
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What is a function? 

A function includes a SQL statement and some arguments. A function can be 

used to execute a SQL statement, and tell PTReportGen whether or how to 

add data into a report. 

 

How can I test a SQL statement? 

You can test SQL statements using Microsoft Query that is a component of 

Microsoft Office. You can find it under the installation directory of Microsoft 

Office. 

“C:\Program Files\Microsoft Office\OFFICE11\MSQRY32.EXE” 

 

When I execute a SQL statement, I receive an "ODBC driver does not 

support the requested properties." error message. 

It probably is a wrong SQL statement. Such as a missing column, or syntax 

error. 

 

How can I sort data? 

Use SQL to sort your data. In a SELECT statement, you can use the ORDER 

BY clause to have your results displayed in a sorted order. 

 

How can I have total?  

You can use aggregate function in SQL statement.  

1. In the fixed table report, you can add total directly using a separate SQL. 

2. In the variable table report, you must add total first using a Fixed Table 

report function before you use the Variable Table report function. Because the 

cell address of the total field will change after you use Variable Table report 

function. 
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How can I group data? 

To group data in a report, you can use GROUP VARIABLE TABLE REPORT 

function. For more detail information, refer to PTReportGen Help and the 

samples customer_profile.ptr, product_catalog.ptr and sales_detail.ptr within 

PTReportGen. 

 

How can I make sub reports within the main report?  

A subreport is a report within a report. A subreport would typically be used to 

perform one-to-many lookups such as Customer / Order / OrderDetails. 

To make sub reports within the main report,  

1. Write a JOIN SQL statement to access data from two or more tables. For 

example, you can join Customers, Orders and OrderDetails tables. 

2. Use GROUP VARIABLE TABLE REPORT function. 

For more detail information, refer to the samples product_catalog.ptr and 

sales_detail.ptr within PTReportGen. 

 

How can I have sub-totals for each group? 

You can use aggregate function in SQL statement.  

1. Use aggregate function and GROUP BY clause, get summary data for each 

group, and insert results into a temporary table. 

2. If you have different kinds of summaries, repeat the step 1, and insert results 

into another temporary table. 

3. Use group report function, and join the detail data and the summary data 

using JOIN. The summary fields must be included in the group list.  

4. Except for sub-totals, you can add total too using aggregate function in SQL 

statement. You must add total first using a Fixed Table report function before 

you use the Variable Table report function. Because the cell address of the 
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total field will change after you use Variable Table report function. 

For more information, refer to the sample sales_detail.ptr within PTReportGen. 

 

How to use parameters? 

In SQL statements, you can use parameters.  

1. To use a parameter, you must declare it first. A parameter has a name, a 

title and a default value. To define a parameter, click Configuration on the 

Report menu, and click the Parameter tab 

2. In SQL statements, use the parameter name. 

PTReportGen will replace the parameter name with the actual value before it 

submits the SQL statements to data sources. 

Example 

Define a parameter as follows:  

Name: $CustomerName 

Title: Customer Name 

You can use the parameter name "$CustomerName" in SQL statements. The 

parameter name in SQL statements should be delimited by quotation mark. 

For example:  

SELECT CompanyName 

,CityName 

,CountryName 

,ContactName 

FROM Customers, Cities, Countries 

WHERE Customers.CityCode = Cities.CityCode 

AND Customers.CountryCode = Cities.CountryCode 

AND Customers.CountryCode = Countries.CountryCode 

AND CompanyName LIKE '$CustomerName%' 
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I need to change paths for both exported report and template location. Is 

there any way? 

You can use parameters in the path and name of the report file, template file 

and log file. For example, you define a parameter $CustomerID, you can name 

the report file as follows: 

report\report_$CustomerID.ppt 

report\$CustomerID\report.ppt 

 

Can I place the data into columns rather than rows?  

Of course, just write FILLORDER=col in REPORT function. For example, there 

are 1 field and 10 records, you can show them as 1 row and 10 columns on 

report. 

 

How to create Microsoft PowerPoint reports with pictures? 

You can insert pictures into your report from using many popular graphics files 

PTReportGen. 

1. Store the path and name of the graphics files in the database. 

2. Identify the image fields in the report function. 

3. To specify the size, you can write a formatting expression into the cell or 

field in the report template file. 

PTReportGen will read the graphics files, insert them into the report, and 

change the size of the pictures. 

 

I want to use FROM report. How can I know the name of a shape or text 

box? 

To use a form report, you can reference a shape or text box by its name. We 

developed a PowerPoint add-in "name.ppa" that can display the name of an 

object and rename the object in a slide. You can find the add-in under the 
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PTReportGen's working directory. 

 

How do I load a PowerPoint add-in? 

To load an add-in: 

1. Launch Microsoft PowerPoint. 

2. Click Add-Ins under Tools menu. The Add-Ins dialog box appears. 

3. Press Add New button, and browse to the add-in file, and Press OK button. 

4. If prompted to enable macros, press Enable Macros button. The add-in will 

be listed in the Add-Ins dialog box. Press Close button to close the dialog box. 

 

I tried to load an add-in but I do not see it listed in my Add-Ins dialog box. 

Why? 

Check the macro settings. If this is not set to at least Medium, the add-in won't 

load. To resolve this: 

1. Click Macros under Tools menu, and click Security. The Security dialog 

box appears. 

2. Click the Security Level tab, and click Medium. 

3. Press OK button. 

4. Now load the add-in. 

5. Once the add-in has been loaded you can set the security level back to 

High. 

 

I can not save the change to the name of object. What is wrong? 

I have renamed the object in a slide using the add-in “name.ppa”, and saved 

the PowerPoint file. But I find I do not save the change when I reopen the 

PowerPoint file. It may be a problem of Allow fast saves option. You should 

save a complete file. 

1. On the Tools menu, click Options, and then click the Save tab. 
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2. Clear the Allow fast saves check box when you finish working on the file, 

and then save it one last time. A full save occurs when this check box is clear. 

 

Do I need to execute more than 1 SQL statement in one report 

processing? 

In most of reports, you just need to execute one SQL statement. But 

sometimes, you want to execute more than one SQL statement in one report 

processing. 

n  The data are located in different tables or databases, and you get data 

using different queries. 

n  There are many reports in one report file. 

n  You want to create a temporary table, prepare data using many SQL 

statements including INSERT/UPDATE/DELETE/INSERT SELECT, and 

then make a report. 

 

How many SQL statements can I execute in one report processing? 

It is dependent on the license of PTReportGen you have purchased. For 

detailed information, see Licenses. 

 

I want to programmatically change some of the functions in the ptr file. 

How? 

The PTR file is a text file. You can write a program to make a PTR file using C, 

Perl or DOS shell, and then run PTReportGen to generate report. These steps 

can be written into a batch file. 

 

I do not want to save password in the PTR file. Can I use PTReportGen? 

Yes. If you do not save a password in the PTR file, a login dialog box will 

appear when you run the PTR file in PTReportGen. You can input password 
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interactively to log on to the data source. If you want to run PTReportGen in 

command line mode, you can input usernames and passwords in command 

line. 

 

Support 

 

How much will I pay for the technical support? Is it free?  

Yes, it's completely free for all. 

 

I have more questions - who should I write to? 

Please send your additional questions to support@ljzsoft.com. 

 


